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Guide to System Documentation

The BT Versatility is provided with the following range of documentation:

Get Started Guide

Provides overview of System Programming and Key Features

The Get Started Guide takes the user through key system programming
and enables the user to modify basic system configurations to suit their
business requirements. In addition, it allows an appointed ‘Administrator’ to
configure the system, through key settings and programming elements,
enabling a tailored business solution.

Phone Quick Reference Guide

Provides Quick Reference to Key System Features

The Phone Quick Reference Guide is supplied with each BT Versatility
system as an easy to view fold out for each system user. Also provided is a
simple reference to the key operation and system features of
Featurephones or Standard Telephones.

Detailed User Manual

Provides complete detail on System Programming and Features

The Detailed User Manual is provided on a CD-ROM with each

BT Versatility System, covering System Programming, Administration and
Usage, and providing the appointed ‘Administrator’ with information on
configuration of advanced system features.

Detailed Internet Module Manual

Provides complete detail on Internet Module Programming and Usage
The Detailed Internet Module Manual is provided on a CD-ROM with each
BT Versatility System, covering System Programming, Administration and
Usage, and providing the appointed ‘Administrator’ with information on
configuration of advanced system features.

BT Versatility Wizard User Manual

Provides complete detail on programming of BT Versatility with

PC Configuration Tool

The BT Versatility Wizard User Manual is provided on a CD-ROM with
each BT Versatility System.
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System description

e The BT Versatility is an Integrated Communications System. It supports
all your voice call needs and an Optional integrated Data Solution that
allows multiple simultaneous Internet sessions.

e The BT Versatility can accommodate up to 8 Analogue Lines, 4 Digital
Lines, or a combination of both, with up to 32 Extensions.

System Options

Your BT Versatility may be delivered or installed with additional optional
modules, or you may choose to purchase them at a later date. The
following options are available:

¢ Additional Extension Modules to a maximum of 32 extensions

e Additional Digital or Analogue Line Modules to a maximum of 8 lines

e Optional Internet Module for shared High Speed Internet Connections
e Optional Voicemail Module for professional voice services

e Optional Battery Back Up Module for full system operation in power fail

e Options Module for connecting Long Line Extensions, External Music on
Hold or Central Bell

e “V8” Featurephone with full Menu Display, Handsfree Operation and 8
Programmable keys

e “V16” Featurephone with full Backlit Menu Display, Handsfree
Operation and 16 Programmable keys

e “V16” Expansion Console providing an additional 32 Programmable Keys
when used in conjunction with the V16 Featurephone

e “V” System Terminal with CLI Display, Monitor Function and
Programmable Keys

e Door Intercom to facilitate visitor introduction

e Hospitality software for customers that either have a hotel or guest
houses or any business that needs to bill individual clients
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System Support
BT Versatility Support Web Site: www.productsupport.bt.com/

BT Sales 0800 800 152
BT Service 0800 800 154
BT Versatility Helpdesk 0870 240 8377

System Programming Notes

The BT Versatility may be programmed from either a V8/V16
Featurephone or from the BT Versatility wizard configuration tool supplied
on the CD-supplied with your system. This guide outlines the key elements
of System Programming from the Featurephones only.
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Guide to Featurephone layout

Secrecy | Hands-free | Volume | 4 Function Keys
Key and light Keys Programming
Message Retrieval
Speed Dial Lists
Network and ISDN

Voice message-
indicating light

6 Display
Keys

Programmable
keys.
(16 V16 /8 V8)

Clear Scroll /
Key Edit keys

This diagram illustrates the V16 phone which has 16 programmable keys

Explanation of Symbols *Used in this manual

Specific symbols are used to define particular operations or to highlight
important areas as follows:

Caution

I >

Program Programming Key
Select Function

Scroll through Menus 5

v d
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System Programming

The System may only be programmed from one specific extension, by
default this is configured as Extension 20, but the programming position
may be moved to any Extension required.

The System Programming is separated into 3 main blocks:

System covers aspects that affect operation across the complete system

Extension covers aspects that may be programmed per extension

Lines covers aspects which affect the Network connections, Incoming and
Outgoing Calls, and Least Cost Routing configuration.
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Instruction Action Menu Display
From the Programming Position ---Phone Setup---
(Ext. 20 by default) select the -Auto Answer
Programming Key -Key Programming
-Headset Mode
Program
Scroll through the menus to find ---Phone Setup---

(System Programming) and select the
option

S
>
>

-Ringing Options
-Contrast Options
-System Programming

Enter Password

Enter System Password

Default 1111 -Exit
You are now in the‘ Main Menu for — Select Option
System Programming and are presented -System
with the following Sub Menus for - -Extensions
Programming Options <> _Lines

> > >

the CD-ROM packaged with your system.

The remainder of this document assumes that you have successfully
navigated to the System Programming Sub Menu above.

Depress the D key for 2 seconds at any time or Hang Up to exit the
Programming mode at any time. Modified settings are SAVED automatically.

For more complex settings please refer to the Owners Manual provided on
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Programming System Time & Date

Instruction

Action

Menu Display

From the System Programming
Sub Menu Select [System]

1l

Select Option
-System
-Extensions
-Lines

Select [Time & Date]

1l

Select Option

-Time & Date

-Change Password
-Programming Position

Enter Time [HHMM]

|

Set Time HHMM
-Confirm
-Exit

Enter Date [DDMMYY]

29 9 9

|

Set Date DDMMYY
-Confirm
-Exit

Note: Time & Date Settings are saved automatically.
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Configuring a Group (Ring/Hunt Group)

Configuring Group & Assigning Extensions

Instruction

Action

Menu Display

From the System Programming
Sub Menu Select [Lines]

Select Option
-System
-Extensions
-Lines

Select
[Group Programming]

Select Option
-Equipped Lines
-Group Programming
-Incoming Ringing

Select the Group to be Programmed
[Scroll If Necessary]

Select Group

-Group1  Group 4-
-Group 2 Group 5-
-Group 3 Group 6-

Select the Group type to be
programmed

Select Group Type
-Ring Group
-Hunt Group

-Exit
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Configuring Group & Assigning Extensions/continued

Instruction Action Menu Display

If RING GROUP selected

Select the Extensions to be included Select Extensions
in the RING GROUP -Ext. 20 Ext. 23-
-Ext. 21 Ext. 24-
<> Ext.22  Ext.25-

S

>
Scroll
If HUNT GROUP selected

Select the HUNT GROUP type required Select Hunt Group Type
o> hnex
-Circular

> -Longest Idle

(See Next page for Note on Group Types)

Select Extensions
-Ext. 20 Ext. 23-

@% -Ext. 21 Ext. 24-
<;§ <™ Ext.22  Ext.25-

Select the Extensions to be included
in the HUNT GROUP

10
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Note on Groups & Group Types

Note:

Note:

Ring Group:

Hunt Group:

Group Programming

When assigning Extensions within a Ring or Hunt Group the first
8 extensions are included by default in Group 1. The administrator
may select or deselect Extensions within a Group at any time.

Group Names

All Groups can be assaigned specific names to facilitate ease of
program and system usage. Please refer to the section on Naming
in this document for instructions on creating Group or Extension
names.

Groups of different types may be configured in your BT Versatility
System. When programming a Group you will be offered the
following options:

When selected all phones in the Group ring simultaneously for an
incoming call

When selected incoming calls are presented to one phone only
within the group and the calls are filtered through the various
Extensions as follows:

e Linear
Calls are presented to the lowest numbered extension first. If an
extension is busy the call is presented to the next free extension.

e Circular
Calls are presented in strict rotation starting with the lowest
numbered extension in the Group (i.e. Call 1 is presented to
Extension 20, call 2 to Extension 21 etc.)

e Longest Idle
Incoming calls are presented to the extension that has been idle
for the longest period of time.

11
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Mapping Incoming Calls to a Group (From a Network Line)

Instruction

Action

Menu Display

From the System Programming
Sub Menu Select [Lines]

>
>
S

Select Option
-System
-Extensions
-Lines

Select
[Incoming Ringing]

Select Option
-Equipped Lines
-Group Programming
-Incoming Ringing

Select the Line or Access Select Line
- Line 2
o> ™
-Access 1
= -Door Intercom
Scroll
Select the time Select Option
<> -DayMode
-Night Mode
S— 9
-Day & Night Mode
>
Select the Destination for Incoming Select Destination
Calls on this Line or Access [ Group In g&%o -Extension
This Case] -Group
e -Auto Attendant
>
Select the Group which is to receive Select Group
Incoming Calls on this Line or Access -Group 1 Group 4-
during the relevant Time Period -Group 2 Group 5-
> -Group 3 Group 6-
>
Scroll <>

Note on Incoming Call Mapping

You may map Incoming Calls on Specific Lines to be presented to different Groups in

Day and Night Mode.

12
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Mapping Incoming Calls to a Group (From an MSN or DDI)

Instruction

Action

Menu Display

From the System Programming
Sub Menu Select [Lines]

Select Option
-System
-Extensions
-Lines

Scroll down and select
[DDI Programming]

Select Option
-DDI Programming
-ISDN Programming

-Exit
>
Scroll <>
Enter MSN Index 001 — 100 Enter MSN Index
May be Existing or New XXX - Exit
Enter MSN/DDI Number e
May be Existing or New XXXXXX XXX -Confirm
Confirm when complete -Change
-Delete  Exit-
Enter MSN Name e
May be Existing or New ABCDEFGHIJ -Confirm
Confirm when complete -Change
-Delete  Exit-
Select the time — Select Option
-Day Mode
%Q -Night Mode
>

-Day & Night Mode

Select the Destination for Incoming

Calls on this MSN or DDI

Select Destination
-Extension

-Group

-Auto Attendant

Select the Group that is to receive
Incoming Calls on this MSN or DDI

Number during the relevant time period.

Select Group

-Group 1 Group 4-
-Group 2 Group 5-
-Group 3 Group 6-

[To Select a group(s) select the
diamond next to it ]

13
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Configuring Call Barring Rules

14

Call Barring and Tables

Call Barring allows you to prevent specific extensions making specific
types of calls in Day or Night Mode. In order to configure Call Barring, you
first set up the rules [Class codes] as described below, and then assign the
relevant call barring levels to individual extensions.

There are four Tables which may be programmed and six [Class codes]
which may be assaigned to an extension as listed below.

Type of Restriction Table Class Typical Use
No restriction None 1 Allow ALL
Restricted from calls in Table 2 2 2 Bar 00
Restricted from calls in Table 2 & 3 3 3 Bar 0
Allowed Internal and Emergency Calls only None 4 Bar ALL
Allowed Numbers that overide Table 2 & 3 5 5 Exception
Restricted Numbers that overide Table 1,2 &3 6 6 Specific Bar
Table Bar Default settings

Table 2 International “00”,“14100”,“147000”,“192”,“153", “128000”
Table 3  National “0”,“1410”,“147007,“192",“153", “12800”




Setting up Call Barring Tables

Instruction

Action
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Menu Display

From the System Programming

Select Option

Sub Menu Select [System] p— -System
-Extensions
T Lines
Scroll down and select Select Option
[Class Codes] -Class Codes

-Reset Options
-Set v24 Baud Rate

>
Scroll >
Select the Table which is to be Select Table
programmed %Q -Table 2
-Table 3
<" _Allowed Table/Restricted Table
>
Enter Index 01 - 50 Enter Index 01 - 50 - Enter the
number or code you wish to
bar here
May be Existing or New Index XX -Exit
Select Confirm to Complete the Set-Up Select Option
o Av
p— -Confirm
[See Note Below for ‘ANY’ Option] -Change

>

Note: Each entry restricts or allows one number or range of numbers. A wildcard may be used ‘ANY’
(i.e. 403 X would bar calls to numbers between 403-1 and 403-0.

15
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Assigning rules to Extensions

Instruction Action Menu Display
From the System Programming Select Option
Sub Menu Select [Extension] %Q -System
-Extensions
> _Lines
>
Scroll down and select Select Option
[Restriction Classes] %Q -Name Programming
-Restriction Classes
- -Tone Protect
>
Select Time for rule to be applied Select Option
Day or Night —— - Day Class of Service
@% - Night Class of Service
T Rt
>
Select the Class Rule to be applied Select Option
Class 1 to 6 —— -Class1  Class 4-
g&% -Class2  Class 5-
<™  Class3 Class6-
> Exit-
Select thg Extensions to which this — Class X  day/night
rule applies -Ext 20 Ext 23-
<> Ext21  Ext24-
<> -Ext22  Ext 25-

[To Select an extension(s) select
the diamond next to it]

Note: You may apply the same rule to multiple extensions.
You may apply multiple rules to the same extension.
You may exit the menu at any time and the settings will be saved.

16
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Instruction Action Menu Display
From the System Programming Select Option
Sub Menu Select [System] -System
_ -Extensions
T Lines
>
Scroll down and select Select Option
[Night Service] -Night Service
-Music on Hold
_ -Line Key Light
>
Scroll <>
Program Night Service On & Off Times Select Option
[Apply Weekend (if required)] - Automatic On Times
_ - Automatic Off Times
<" . Weekend Service
>
Enter On Times Select Option
— -On T!me 1
-On Time 2
> Exit
>
Enter Off Times Select Option
-Off Time 1
@%Q -Off Time 2
T Kt
>
Enter Time to be set and then select Set Time [HHMM]
Confirm @% — - gg:g:
- Delete
>

Note: You may apply 2 sets of times for the Night Service rules to be applied, typically this will be

used for Lunch Time and Out of Office Hours.

Night Service allows you to configure different call routing plans for these time periods.

You may exit the menu at any time and the settings will be saved

17
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Changing System Password

Instruction Action Menu Display
From the System Programming Select Option
Sub Menu Select [System] -System
gfﬁl -Extensions
> _Lines
>
>
Select Select Option
[Change Password] _— -Time & Date
-Change Password
> -Programming Position
>
Enter New Password [xxxx] 1111
4 digit numeric and Confirm % -Confirm
-Change
o
>
>

Examining Extension Passwords

From the System Programming
Sub Menu Select [Extension]

=

S

Select Option
-System
-Extensions
-Lines

Scroll down and select
[Examine Passwords]

< >
=
< >

Scroll

Select Option

-No Call Logging
-External Diversions
-Examine Passwords

Select the password which you need
to view

Select Option

-Ext. Lock Password
-Voicemail Password
-System VM Box

The System VM password is displayed
immediately.

Select an extension to view

it’s Password.

Select Extension

-Ext 20  Ext 23-
-Ext 21 Ext 24-
-Ext 22 Ext 25-

18
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Instruction Action
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Menu Display

From the System Programming

Select Option

Sub Menu Select [Lines] -System
_ -Extensions
<™ lines

Scroll down and select Select Option

[System VM Box] S -Outgoing Line Priority
<™ _PABX Group
>

Scroll

-System VM Box

Select the Line(s) which are to be
answered by the System Answering
Machine when it is enabled

S
>
S

System VM Box
-Access 1

-Line 1

-Line 2

Note: To utilise the Voicemail features on the BT Versatility, you must purchase the optional

Voicemail module

Enabling System Voicemail Box

From Extension 20 in idle menu Scroll
down and select

>
>
>

[System VM Box]

-Internal call
-Redial last number
-Saved numbers

Scroll down and select

[System VM Box]

< >
=
< >

Scroll

-Night service
-System VM Box
-Divert

Once enabled extension 20 idle
menu appears as shown

S
S
S

-System VM box
-Internal call
-Redial last number

19
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Assigning Voicemail Extensions

Note: To utilise the Voicemail features on the BT Versatility,
you must purchase and install the optional Voicemail module

Instruction Action Menu Display
From the System Programming Select Option
Sub Menu Select [Extension] -System
@%Q -Extensions
<> _Lines
>
Scroll down and select Select Option
[Voice Boxes] - -Individual CLI Stores
> -System Speed No O/ride
< >  -Voice Boxes
Scroll

Select the Extensions which are to be Select Extension

assigned individual Voicemail Boxes -Ext 20 Ext 23-
<> Ext21  Ext 24
<> Ext22  Ext25-

<> [To Select an extension(s) select
the diamond next to it |

Assigning Voicemail Capacities

Note: The system assigns a limit of 20 Messages per Voicemail Box,
this may be modified if required as follows

From the System Programming Select Option
Sub Menu Select -System
[System] -Extensions
> _Lines
>
>
Scroll down and select Select Option
[System VM Capacity] <> -V24BaudRate
— -VM Capacity
-Account Codes
>
Scroll
Enter the required number of Enter VM Cap. 10-50
messages allowed per extension % -Exit
>

20
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Programming Personal Speed Dials

Instruction Action Menu Display

From the Idle Menu --Directories--

Select the Directory Key -Personal Speed Dial
.- -System Speed Dial
-Personal Entries

Directory -System Entries

Select
[Personal Entries] % - Personal Entries

Enter the Speed Dial number index to Enter SPD Index 01-30

modify an existing entry or a new index 1. Enter Number
to create a new entry 2. Enter Name

S
<> 3. Confirm
S

O

Note: Speed Dial Numbers may be entered from any extension, however the entry of System Speed
Dial numbers is password protected with the Administrator Password.

21
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Programming System Speed Dials

Instruction Action Menu Display
From the Idle Menu --Directories--
Select the Directory Key -Personal Speed Dial
.- -System Speed Dial
Directory -Personal Entries
-System Entries
Select - Password Requested
[System Entries] = - Enter Password
>
>
Enter the Speed Dial number index to > Enter SPD Index 001-500
modify an existing entry or a new index 1. Enter Number
to create a new entry — 2. Enter Name
S 3. Confirm
Select the outgoing group » Outgoing group
(normally the first group) ¢ Qutgoing group 2 (760)
Q « Outgoing group 3 (761)
>
>

22
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Power Fail Operation

Your BT Versatility is provided with a basic power fail mechanism to allow the system to
continue operation in power fail situations.

Analogue Systems
For systems with traditional Analogue (PSTN) Lines two extensions on each extension
module are connected directly to the first two Network Lines on that module as follows:

Line Extension
1/2 26/27
5/6 34/35
9/10 42/43
13/14 50/51

Digital Systems

Systems populated with Digital (ISDN) Lines only will not operate in Power Fail mode.
These systems MUST be populated with the Optional Battery Back Up unit or an
auxiliary uninterruptible Power Supply (UPS)

Battery Backup Unit
The Optional BBU available with the BT Versatility will ensure all system configurations
can operate to full capacity for a minimum of 1 hour under normal load conditions.

23
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Extension Name & Settings

Note: Each Extension on the BT Versatility System may be configured with different settings.
This section describes how to change the Extension names and list the key settings that may be
configured. Please refer to the full User Manual for further instruction if required.

Instruction Action Menu Display

From the System Programming Select Option

Sub Menu Select o> -System

[Extension] -Extensions
T ines
>

Select Select Option
[Name Programming] -Name Programming
— -Restriction Classes

-Tone Protect

>
>
Select the required Extension and Select Extension
enter the name required ) -Ext 20 Ext 23-
p— -Ext 21  Ext 24-
-Ext 22 Ext 25-
>

24
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Additional Extension Settings

See the table below for a full range of settings. The following parameters may
be also be set on an extension by extension basis. Refer to the full ‘User
Manual’ for detailed programming instructions if required.

25 Hz
This allows the ringing frequency to be changed from 25 to 50 Hz.
The default setting is 25Hz however some older phone equipment
may require 50 Hz for ringing this setting should only be applied if a
telephone does not ring correctly at 25 Hzv

3.1 kHz Extension
Allows an outgoing call to be set for 3.1Khz minimum bandwidth. It is
advisable to set this for extensions equipped with a Fax or Modem

Extension Disconnect
Removes an unpopulated extension from all ring maps

Hot Line
Allows an extension to be set to call a pre-programmed number when
the extension goes off hook. Typically used for unsupervised
reception areas or fax machines

Individual CLI Stores
The administrator can decide which extensions have individual CLI
stores

Key Pad Feedback
Allows the keypad tones to be switched on/off on an extension by
extension basis.

Manager/Secretary
Allows specific features to be mapped between a manager and
secretary for improved functionality

No Call Logging
Prevents calls to or from this extension from being stored in the
system call logging information

External Diversions
This prevents or allows extensions from setting up diverts externally
and also prevents an extension from making dual trunk calls, such as
External Transfer, Conference or Consultation

Open Door Restriction
An extension can be restricted from Opening the Door if a remote

25
door opening system is installed
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Page Protect
Removes an extension from the paging group

Permanent CLIR
Allows an extension to be set so that it never sends the CLI number
when making an outgoing call (CLIR)

Permanent COLR
Allows an extension to be set so that it never shows the CLI number
during a connected incoming cal (COLR)

Port Swapping
Allows 2 extensions to be swapped on the system for administration
or programming purposes

Restrict use of PA
Prevents an extension from accessing the PA System if connected to
the system

Reverse Cadence
Allows the administrator to swap the ringing cadence used for
internal and external calls

Set Restriction Classes
Allows Call Restrictions to be placed on an extension by extension
basis. Different rules can be applied day and night if required

Sys Speed Dial O/Ride
Allows an extension to dial a number from the System Store even if
that area code is normally barred from that extension

Tele-Secretary
Allows the call recipient see who the call is for before answering, this
feature is ideal where one secretary answers calls on behalf of several
managers

Tone Protect
Allows an extension to be protected from tones at all times

Voice Boxes
Allows the administrator decide which extensions have individual
Voicemail Boxes

Extension Reset
You can cancel the following if they have been programmed on your
set, Do Not Disturb, Call Divert, Ring Back, Display Messaging,
Reminder Call
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Versatility Numbering plan

Code Feature

100- 109 Phantom voice boxes
110-117 First S, bus numbering
120-127 Second S, bus numbering
130 - 137 Third S, bus numbering
140 - 147 Fourth Sy numbering

150 - 159 First 10 VolP Extensions
160 - 169 Second 10 VolP Extensions
170 -173 Last 4 VolIP Extensions
180- 189 Group 1- 10

190- 199 Group 11 -20

20-29 Extensions 1-10

30-39 Extensions 11-20

40-49 Extensions 21- 30

50-51 Extensions 31 and 32

52 Long Line Extension

9 Line Access (Line Group 1)
0 Extension 20

710 Voice module number

711 Retrieving Voice Messages
712 Pick up a parked call

713 Extension Lock on / off
714 Extension Lock Code Programming
715 Voice Call

716 Page All Featurephones
717 External Paging Answer
718 Call Reminder

718" Cancel Reminder call

719 Return to call placed on system hold

27
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Code Feature

720 Call to a PA amplifier

721 Transfer for Remote maintenance
R 722 Forward Recall analogue lines
723 Log in / Log out of Hunt groups
724 CLIR on an individual call for a standard telephone
725 Tone protection

726 Call Pick Up external

727 Call Pick Up Group

728 Keypad protocol programming on a programmable key
729 Display messaging

731 Operate the doorstrike

732 Call Divert All Calls

733 Call Divert on Busy

734 Call Divert on No Answer

735 Call Divert - Follow Me

736 Do not Disturb Set / cancel

737 System Voicemail box on/off

738 Night Service on / off

739 Phone Reset

7401 - 7430 Personal speed dial Recall

7501 - 7530 Personal Speed Dial Programme
760 - 769 Line Groups 2 - 11

77 Last number Redial

781- 785 Saved numbers Redial

791 Account Codes

792 Group Divert All Calls

793 Group Divert on Busy

794 Group Divert on No Answer

795 Page all
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Code Feature

8001 - 8500 System speed dials

R Call hold (Standard Phone)

R1 Return and release in two call handling
R2 Return and hold in two call handling
R3 Call Conference

R5 Ring back

R8 Forced call waiting

R 712 Call park

R725 Tone protection

29
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Configuring the Internet Module

This section describes how to configure basis Network Settings on the
Internet Module to enable you to connect to the Internet, and to an ISDN
or ADSL Internet Service, assuming that you accept all default Internal
Network Settings. Please refer to the Internet Module User Manual
provided on the enclosed CD-ROM if you need to configure additional
options on the Internet Module.

e When the Internet Module is
installed and running run the BT Versatility
Wizard tool on a PC connected Router Module
to the system via the
V.24/Serial Port Interface.

Installation Wizard

e When you run the application Router Settings
Screen 1 will be displayed. Networking
From this screen Select the

‘Installation Wizard’

Screen 1

In the next screen displayed (Screen 2), select either ISDN or ADSL
depending on the type of connection you have to the Internet.

30
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Ensure the Internet Module is connected to an ADSL Modem that is
working correctly with the ADSL Service.

e Set Profile Name
(<20 characters)

e Set Username

e Set Password

¢ Enable the Profile

The service is now configured.

ISDN Service

BT Versatility
ADSL Installation Wizard

Profile name

—

Username

—

Password

—
Prohle Active
Yes (@) No @)

Screen 2

Ensure the ISDN Lines are connected and working through the BT

Versatility System.

e Set Profile Name
(<20 characters)

e Set Username

e Set Password

e Set the Phone Number of
the ISP

¢ Enable the Profile

The service is now configured.

BT Versatility
ISDN Installation Wizard

Profilc name

Username

——

Password

Tel No

Profilc active
Yes @ No(@)

Screen 3

31
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BT Versatility Wizard Management Tool

The BT Versatility Wizard Management Tool enables the system
administrator to program and modify system configuration through a
simple User Interface. The application contains extensive Help Files that
will guide you through key system settings. BT Versatility Wizard is
installed from the CD-ROM provided with your BT Versatility System.

e The application may be run at any time by inserting the CD-ROM and
selecting Start/Programs/BT Versatility Wizard in the Start Menu on
the PC.

e The Administrator’s PC must be connected to the BT Versatility using the
supplied Communications cable between the serial port on the PC and
the BT Versatility.

e When the application is running you must establish a connection to the
BT Versatility by choosing: Connection / Connect

File System Exte Hotel Lines Diagne Flash Upload Router Debug Connection Help
[Fecone ] sonseecten [sontcranes| sove] [loss Gurrent pane

2 [setRange onJset Range ofrecene seected]

Extension Class of Sorvce |

1 2 3 T 5 6 7 8 9 0
55 1 = s s s =

odes

ss 1

[ g

ol
Codes
i

OogoOg
OogoOg
OogoOg
Hogoog
OogoOg
OogoOg

OogoOg
OogoOg
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In the menu options select the settings as shown (using the assigned Com
port on the PC).

Once the connection is established you will view information live on the
system.

All available settings may be modified or updated without affecting calls in
progress on the system.

Once a setting is modified you must SEND this to the BT Versatility. This
may be done by:

e Selecting ‘Send Changes’ to send all updated fields

¢ Highlighting particular fields and selecting ‘Send Selected’

& select connection medium E3 |

® V24 viaserialPort  1SDN O PSTN () UDP Test

115200 ¥ COM1 ¥

Cancel Connect

33



Connections that get results.
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